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1. Einleitung oder worum es hier geht

Dieses Tutorial soll als Einstieg in den Layouteditor von Eagle dienen.
Mit dem Layouteditor wird das Design der Platine bestimmt. Es wird also festgelegt wo die
Leiterbahnen liegen sollen, wie stark sie sein sollen, wo gebohrt werden muss und vieles
mehr. Das Layout der Platine ist quasi der letzte Schritt vor dem Ätzen und bestücken.

 

Als Grundlage soll ein bereits existierende „Schematic“ - Schaltplan dienen.

 Abbildung 1: Schematic Schaltplan

Vorab aber erst etwas zu den Funktionen und Besonderheiten von Eagle.
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Schaltplanentwurf:
Eagle “Schematic”

Schaltplanlayout:
Eagle “Layout”

Schaltplansimulation:
“PSpice” / “Spice”

Zeichnung 1: Eingliederung des Layouteditors

Schaltplanentwurf:
Eagle “Schematic”

Schaltplanlayout:
Eagle “Layout”

Schaltplansimulation:
“PSpice” / “Spice”
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2.  Allgemeines zum Programm

2.1. Das Control Panel

Über das Control Panel können alle wichtigen Dateien erreicht und bearbeitet werden.
Besonders wichtig sind hier die Sektionen „Bibliotheken“ (Libraries), „Scripts“,
„Design Rules“ und natürlich „Projects“. 

Falls eine nähere Erklärung zum gerade gewählten Punkt existiert, wird diese im rechten
Fenster angezeigt. Dies sehen wir später noch bei den Bibliotheken. 

2.1.1 Scripts

Über Scripts kann die Funktionalität von Eagle erhöht werden.
Gute Beispiele sind das Script „euro.scr“ welches eine Europlatine  zeichnet und das
ULP „drill-aid.ulp“ mit dem Pads und Vias ausgefüllt werden wobei ein Zentrierungsloch
verbleibt. 
Da Eagle intern  mit einfachen Textkommandos arbeitet, sind beliebig komplexe Scripte
möglich. „User Language Programms“ stellen ähnliche Funktionen zur Verfügung. 

Nähere Informationen und viele fertige Scripte finden sie unter [1].
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Abbildung 2: Das Eagle Control Panel
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2.1.1 Design Rules

Mit Hilfe der Design Rules kann man bestimmte Eigenschaften des neuen Layouts
einstellen. Hierzu gehören z.B. Linienstärke, Linienabstand, Bohrlochgröße,
Bohrlochabstand usw. 

Diese Eigenschaften sind auch
beim „Design Rule Check“
eingestellbar, allerdings werden
sie dann natürlich beim verlegen
der Leiterbahnen noch nicht
berücksichtigt.

2.1.2 Bibliotheken (Libraries)

Einer der zentralen
Bestandteile Eagle`s sind die
Bauteilbibliotheken, in denen
neben dem Schaltsymbol auch
die bedeutenden physischen
Eigenschaften der Bauteile
gespeichert sind. 

Wichtig für das Layout sind
hierbei in erster Linie die
Abmessungen, Pinabstände
und Pinbelegungen der
Bauteile. 

Elektrische Eigenschaften, wie
sie zur Simulation gebraucht
werden, können/ müssen aber
nicht vorhanden sein. 

5/23

Abbildung 4: Control Panel mit geöffnetem Bauteil

Abbildung 3Einstellungen der Design Rules
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Einige häufig benötigte Bibliotheken: 

Suchbegriff Beschreibung
frame Zeichungsrahmen und Ports
supply Versorgungsspannung, GND ...
rcl Widerstände, Spulen, Kondensatoren
transistor Transistoren
linear Vieles gebräuchliches (OPV´s, Widerstände....)
pin, con- Stecker und Gehäuse
40xx, 74xx Logikbausteine
19“ Platinen
diode, led, linear Operationsverstärker

Falls des gewünschte Bauelemente nicht verfügbar ist, kann es mit dem Bauteileditor
erzeugt werden.  
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Abbildung 5: Der Bauteileditor
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2.1.3 Projects

Unter Projects werden alle Eagle-Projekte aufgelistet. Jedes Projekte bekommt dabei
seinen eigenen Unterordner in dem alle projektbezogenen Dateien zusammengefasst
werden.  

Im rechten Fenster wird eine editierbare Beschreibung angezeigt. 
Sie ist hilfreich um den Überblick zu behalten und sollte benutzt werden.

Der Speicherort kann über Options verändert werden. 
Nach einem Rechtsklick über einem Projektverzeichnis erscheint ein Untermenü in dem
ein neues Schematic oder ein neues Board erzeugt werden kann. 
Mit einem Doppelklick auf einzelne Projektdateien lassen sich diese Öffnen und weiter
bearbeiten.

Im Projektordner finden wir auch unsere Schematic Datei die wir nun weiter bearbeiten
wollen. 
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Abbildung 6: Control Panel geöffneten  Projekten



Eagle – Board Markus Valtin

3. Unser Beispiel

3.1 Vorbereitungen

3.1.1 Öffnen und  Bearbeiten der Schematic Datei

Doppelklicken sie  auf die Schematic Datei,
um diese zu öffnen. 

Im sich nun öffnenden Schematic sind die gewohnten Schaltplansymbole und Aufbauten
zu sehen. Es sei noch einmal erwähnt das Netze mit gleichem Namen automatisch
verbunden sind. 

Um nun zum Layouteditor zu gelangen klicken sie bitte auf das Board Symbol:  oder
klicken sie auf File > Switch to Board.
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Abbildung 7: Öffnen Dialog

Abbildung 8: Schematic Schaltplan

Board Symbol

gleiche Netze
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3.1.2 Der Layout Editor

 Auf der linken Seite finden sie, 
wie bei Schematic, 
die Werkzeug-Schaltflächen (siehe
Anhang) um die Platine zu bearbeiten
und oben die Schaltflächen für
Dateioperationen und
Ansichtenwechsel. 

Unter diesen Programmschaltflächen
finden sie die Schaltflächen für die
Werkzeugeigenschaften, hier für das
Wire Werkzeug.
 
Weiterhin befindet sich über dem
schwarzen Bereich eine Konsole wo
Befehle direkt eingegeben werden
können.

In der unteren Leiste werden
Statusmeldungen ausgegeben. 
Dort finden sich z.B. nähere Erklärungen von Schaltflächen 
(2 Sekunden mit der Maus über der Schaltfläche verweilen), Fehlermeldungen z.B. des
Autorouters oder falls Bauteile falsch platziert werden und es werden dort Anweisungen
zur Handhabung von Funktionen gegeben. 

Der schwarze Bereich beinhaltet unsere Arbeitsfläche mit dem Board welches wir
layouten. Dort werden ebenfalls allen Bauelementen die sich in unserem Schaltplan
finden dargestellt.
 

3.1.3 Layer

Eine Platine kann Aufgrund ihrer Dreidimensionalen Abmaße mehrere Eben beinhalten
auf denen verschieden Leiterbahnen verlegt werden könne. Um diese dritte Dimension in
Eagle verfügbar zu machen, gibt es so genannte Layer die eine Schicht der Leiterplatine
symbolisieren. 
Insgesamt können mit der professionell Version von Eagle 17 solcher realen
Signalebenen bearbeitet werden. Eine Ebene auf der Oberseite der Platine, eine auf der
Unterseite und 15 innerhalb des Platine. 
Für uns kommt, wegen der Herstellungsproblematik, nur die Ober- und Unterseite für
Leiterbahnen in Betracht. 
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Abbildung 9: Eagle Board

Position Befehlskonsole

View/Program 

Werkzeug­
eigenschaften

Platine
unplazierte Bauteile

Werzeugschaltflächen

Statusmeldungen
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Die Verbindungen zwischen diesen Signalebenen (Signallayer) erfolgt über
Durchkontaktierungen (Vias) die durch die gesamte Platine gehen, also durch alle
Signalebenen. 

Diese Vias sind durch Bohrungen in der Platine zu realisieren und müssen deshalb
speziell gekennzeichnet werden. Diese Vias sollten min. 0,6 mm Radius haben, da sonst
die Lötkontaktfläche zu klein wird.

Neben den Signallayern, die eine direkte Physikalische
Entsprechung haben, gibt es noch weitere Layer die
Eigenschaften der Platine symbolisieren. Der Layer 20 ist zum
Beispiel für die Dimensionen, also die Größe verantwortlich.
Weitere solcher Ebenen beinhalten Namen, Werte,
Dokumentation, Pins usw. 
Eine komplette Auflistung finden sie im Anhang II.

Mit dem Change Befehl  können sie sie Ebene (also den
Layer), auf dem sie gerade die Bearbeitung durchführen,
ändern. Genauso läst sich mit dem Change Befehl der Layer
ändern auf dem ein Objekt liegt.

     

Da bei größeren Layouts und beim Drucken viele
Informationen nicht benötigt werden oder stören, kann
man Layer ausblenden. 

Dazu dient der Display Befehl . 
Nun können alle anzuzeigenden Layer ausgewählt
werden. 

Soviel zur Theorie.  :-)
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Abbildung 10: Layer

auswählen

Abbildung 11: angezeigte Layer

ändern
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3.2 Zurück zum Beispiel

3.2.1 Bauteile / Netze im Layouteditor

Nach dem Erzeugen eines neuen Boards aus dem Schematic heraus, finden sie alle
Bauteile links neben einem lehren Rechteck. Dieses Rechteck symbolisiert die Platine und
die Bauteile müssen innerhalb dieser Platine abgelegt werden. Wie sie sehen sind die
Bauelemente in ihren tatsächlichen physikalischen Dimensionen abgebildet und alle
gleichnamigen Netze sind jetzt
miteinander verbunden.

Die gelben Linien symbolisieren
dabei diese Verbindung.
Allerdings werden nur
ungeroutete Verbindungen so
dargestellt, das sind  alle
Verbindungen die noch keine
Leiterbahn auf der Platine
haben.

3.2.2 Informationen zu Bauteilen anzeigen

Mit dem Info Befehl  können sie sich Namen
und Beschreibung von Bauteilen oder von
Netzen (gelbe Linien) anzeigen lassen.     

 

3.2.3 Das Raster

Über den Menüpunkt View > Grid können sie das Raster
ändern. Eagle benutzt dieses Raster um Bauteile zu
platzieren und Leitungen zu ziehen. So wird sichergestellt
dass alle Pins und Leitungen in definierten ganzzahligen
Abständen angelegt werden. Dies ist wichtig damit alle
Bauteilpins z.B. von IC`s auch von den Leitungen erreicht
werden können. Schalten sie jetzt die Anzeige des Rasters an
(Im Grid Fenster: Display > on ) und lassen sie Punkte

anzeigen da Linien schon wieder zu unübersichtlich sind. 
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Abbildung 12Die Arbeitsfläche des Layouteditors

Abbildung 13: Bauteilinformationen anzeigen

Abbildung 14: Raster einstellen
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3.2.4 Platinengröße ändern

Nun wollen wir die Größe der Platine ändern. Für unser Beispiel benötigen wir eine
kleinere Platine da wir nur wenige Bauelemente zu platzieren haben, für unser Projekt
jedoch können sie die Scriptdatei euro.scr aufrufen, die eine Europlatine zeichnet.

Jetzt benutzen wir jedoch den move Befehl 
um die Begrenzungslinie der Platine zu
verschieben. 

Diese Linien sind ganz normal mit dem wire

Befehl  erzeugt, befinden sich jedoch im
Layer 20 (Dimension). 

Platzieren sie die Maus nach dem klicken der
move Schaltfläche in der Mitte der zu
Verschiebenden Linie.

Klicken sie nun einmal um die Linie an die Maus zu heften. Bringen sie die Maus und
damit auch die Linie zur neuen Position und klicken sie wieder einmal um die Linie wieder
abzulegen. 

Verschieben sie nun die Linien solang,
bis  in der Positionsinformation  1.60  1.05
steht wenn sie die Maus in der rechten
oberen Ecke platzieren.

3.2.5 Bauteile anordnen

Nun wollen wir die Bauelemente auf unserer Platine anordnen. 

Dazu benutzen wir wieder den move Befehl  . 
Das Vorgehen ist wie bei den Linien, einmal klicken um das Bauteil an die Maus zu
heften, Bauteil platzieren und wieder einmal klicken um das Bauteil abzusetzen.
Platzieren wir nun die Bauteile wie im Bild 17. 
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Abbildung 15: Platinengröße ändern

Abbildung 16: Platinengröße ändern

Positionsinformationen

rechte Ecke
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Falls sie mehrere Bauteile übereinander platziert haben, können sie das entsprechende
Bauteil immer über das Kreuz in jedem Bauteil verschieben. 
(Bewegen sie die Maus über das Kreuz und klicken sie dann erst um es an die Maus zu
heften.)

Nach dem Platzieren sollten sie auf jeden Fall die Luftlinien neu berechnen lassen. Dazu

dient der ratsnet Befehl  . Ratsnet sollten sie auch während des Platzierens hin und
wieder benutzen.

3.2.6  Bauteil drehen

Der IC muss nun noch gedreht werden. Benutzen sie dazu den rotate Befehl .  Jeder
klick auf das Bauteil dreht es um 90 °, klicken sie also 2 mal.

3.3 Routen

Jetzt könnten wir uns an routen machen, also ans verlegen der Leitungen zwischen den
Bauteilen. Jetzt kommen die oben erwähnten Design Rules zum Tragen, genauso wie so
genannte Netzklassen (class). Mit Netzklassen hat man die Möglichkeit mehreren Netzen
gemeinsame Eigenschaften zuzuweisen. 
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Abbildung 17: Bauteile in richtiger Anordnung
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Netzklassen werden in Eagle unter 
Edit > Edit classes verwaltet und mit
dem change Befehl werden einzelne Netze
einer Netzklasse zugeordnet. 

Ein gutes Beispiel für die Verwendung von
Netzklassen ist die Masseleitung, die etwas
Stärker ausfällt. 

Das Routen kann prinzipiell auf beiden Seiten
der Platine erfolgen, jedoch ist aus
ökonomischen und Designgründen ein
einseitiges Layout zu bevorzugen da hier keine Leitungen unter Bauteilen verlaufen und
das Löten einfacher wird.

Man kann die Leitungen auf zwei Arten verlegen, erstens manuelle mit dem route Befehl

 aber als fauler Elektrotechniker benutzt man lieber den Autorouter der einem diese
stupide Arbeit abnimmt. (Der „gute“ Elektrotechniker macht natürlich alles lebst.)
Gebräuchlich ist auch eine Mischung von beidem, man verlegt einige wichtige Leitungen
am Anfang selbst und lässt den Autorouter den Rest verlegen.  

3.3.1 Der Autorouter

Unser Freund wird über die
Autorouter - Schaltfläche

 gestartet und zeigt uns
als erstes seinen
Konfigurationsdialog. 

In diesem Dialog können wir
einstellen ob wir beide Layer
benutzen wollen, welches
Raster Kostenfaktoren usw. 

Wenn wir den Autorouter in der Konsolenleiste starten ( mit auto ) können wir noch die
Netznamen angeben die verlegt werden sollen. 
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Abbildung 18: Netzklassen

Abbildung 19: Der Autorouter
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Nach dem Aufruf über die Schaltfläche
werden alle Leitungen verlegt. 
Dabei benutzt der Autorouter die oben
erwähnten Design Rules.

Wir lassen erst einmal alle Einstellungen
und bestätigen mit OK.

Nach kurzer Berechnungszeit sind alle
Leitungen nach Bild 20 verlegt.

  
Die Ergebnisse können schon nach
kleinen Änderungen 
(z.B. verschieben von Bauteilen) stark
differieren also ist hier etwas testen angesagt. 

Dieses Ergebnis ist für uns jedoch unbefriedigend da hier Ober- und Unterseite benutzt
wurden. Die roten Linien liegen hierbei auf der Oberseite und die Blauen auf der
Unterseite.

3.3.2 geroutete Linien auflösen

Um einzelne bereits verlegte
Leiterbahnen wieder in Luftlinien zu
verwandeln benutzt man den ripup

Befehl . 

Nach Auswahl diese Werkzeugs klickt
man auf den Leiterbahnabschnitt der
aufgelöst werden soll. 

Es werden nur gerade Linien aufgelöst
wie im Bild 21 zu sehen.

Hier wurden bereits zwei Linien
aufgelöst. 

Um die komplette Linie aufzulösen muss man zweimal klicken.

Alle Linien kann man ebenfalls auflösen (z.B. nach einem so missglücktem autorouten).

Man klickt dazu auf die ripup Schaltfläche  und anschließend auf die go Schaltfläche

 ganz oben. Man wird dann gefragt ob man alle Linien auflösen will was wir bestätigen.
Danach haben wir wieder unsere Luftlinien.
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Abbildung 20: Die geroutete Platine

Abbildung 21: Leiterbahnen auflösen
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3.3.3 Autorouter 2

Jetzt wollen wir noch einmal
den Autorouter bemühen,
diesmal aber die Benutzung
der Oberseite verbieten. 

Dazu Stellen wir bei den
„Preferred Directions“ Top auf
N/A. 
 
Eine Erklärung der
Auswahlmöglichkeiten finden
sie im Anhang.

Nun erhalten wir dieses Ergebnis:
(Bild 23) 

Dies benutzt zwar nur die Unterseite ist
aber trotzdem nicht sehr schön da die
Leiterbahnen viel zu dicht an den
Kontakten vorbei gehen. 

3.3.4 manuelles Routen

 
Wir lösen deshalb die Leiterbahnen 
zu R1 auf und Drehen R1 um 180 °,
so wie in Bild 24.
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Abbildung 22: Autorouter mit Einstellungen für Top

Abbildung 23: geroutete Platine

Abbildung 24: Platine mit aufgelösten Leiterbahnen
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Nun wählen wir den route Befehl   und klicken auf den Anfang der zu verlegenden
Luftlinie. Jetzt haben wir eine blauen Linie an der Maus kleben. Jeder Klick auf die Platine
verlegt die blaue Leitung vom Anfang bis zu diesem Punkt. Die Blaue Leitung bleibt dabei
an der Maus kleben und kann weiter verlegt werden. 

Sie fällt erst von der Maus ab, wenn das Ende der Luftlinie erreicht ist oder doppelt
geklickt wurde.  

Verlegen wir nun die 2 Leitungen nach
Bild 25. 

An jedem Knick in der Leiterbahn wurde
einmal geklickt. (Die Bauteile wurden
teilweise auch verschoben).

Der route Befehl hat, wie fast alle
Werkzeuge, weitere Einstellungen wie
in Bild 26 zu sehen.

Man kann hier den Layer einstellen, auf dem gezeichnet werden soll, die Linienform, die
Linienstärke, die Via-Form usw. Während des routens lässt sich die Linienform auch mit
einem Rechtsklick umschalten. So kommen z.B. die schiefen Leiterbahnen zustande.

3.3.5 Bauteile verschieben

Wie erwähnt, lassen sich Bauteile auch nach dem Routen noch verschieben. Die
Leiterbahnen werden dabei ebenfalls verlängert oder verkürzt. 
Ggf. muss man auch die Leiterbahnen verschieben. 
Für beides benutzen wir wieder den move Befehl.

3.3.6 Forward / Back Annotation

Durch die Forward / Back Annotation ist es möglich den Schaltplan nach dem Routen zu
ändern wobei die Änderungen in das Board übernommen werden.

Dazu löschen wir jetzt den Widerstand R2 im Schematic wie in Bild 27.
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Abbildung 25: zu verlegende Leiterbahnen

Abbildung 26: Werkzeugeinstellungen des wire Befehls
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Wechseln sie jetzt wieder ins Board
( benutzen sie die Schaltfläche ).
Das geänderte Board sehen sie in Bild 28.

Wie sie sehen wurde der Widerstand entfernt
und durch eine Luftlinien ersetzt.
 

Einige Leitung werden aus didaktischen Gründen jetzt
neu verlegt, so das sie wie in Bild 29 liegen.
 

3.4 Design Rule Check

Nun wollen wir unser Layout auf die vorgegeben Design Regeln testen. 

Dazu wählen wir die Schaltfläche DRC  aus. Im Konfigurationsdialog (Bild 30) können
wir die Design Regeln nach denen das Board geprüft wird ändern. 
Wichtig sind hier z.B. die Abstände zwischen zwei Leitungen, zwischen Leitung und Rand,
zwischen Leitung und Via usw. 

Diese sollten wir in den Design Rules (siehe 2.1.1) schon definiert haben. 
Der Default sollte für unsere Bedürfnisse ausreichen.
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Abbildung 27: verändertes Schematic

Abbildung 28: Automatisch geändertes Layout

Abbildung 29: Platine für den DRC



Eagle – Board Markus Valtin

Wir bestätigen mit OK und
falls unsere Schaltung Fehler
enthält, werden diese jetzt
angezeigt.

In unsere Schaltung sind
natürlich Fehler und Eagle gibt
Bild 31 aus.

Hier sehen wir links
oben wo unser Fehler
ist. 

In unserem Fall
schneien sich zwei
Leiterbahnen. 

Im Fenster DRC Errors
werden Layer und Art
des Fehlers angezeigt. 

Die Layeranzeige hilft uns den Fehler zu finden, falls der Layer in dem der Fehler auftritt,
nicht angezeigt wird ( z.B. falls wir einen Leiterbahn in einem geschützten Bereich verlegt
haben, Layer 42 bRestrict ).

Falls keine Fehler auftreten erscheint in der unteren Statuszeile no errors. (Bei uns steht
dort 2 errors).
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Abbildung 30: Konfigurationsdialog des Design Rule Check`s

Abbildung 31: Fehleranzeige des DRC
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3.5 Board Drucken

Nun ist unser Board soweit fertig und wir können zum Ätzen übergehen. Um die
Belichtungsvorlage zu erstellen müssen wir zuerst die Anzeige so ändern, dass nur noch
die Layer Top (für die Platinenoberseite) bzw. Bottom (für die Platinenunterseite), Pads,
Vias und Dimensions angezeigt werden (siehe Bild 32 für die Platinenunterseite). 

Die Anzeige können sie über den Display Befehl  ändern (siehe 3.1.3 Layer).
  
Für Doppelseitige Platinen muss für jede Seite ein solcher Ausdruck gemacht werden, die
dann Deckungsgleich auf die zu belichtende Platine gelegt werden müssen, so das die
Vias genau übereinstimmen.

Über File > print gelangen sie zum
Druckdialog (Bild 33). 

Hier müssen die Einstellungen sold, black und
scale factor = 1 gesetzt sein. 
Sold und black sorgen dafür das alle farbigen
Flachen fest und schwarz gedruckt werden. 
Scale factor = 1 sorgt für den verzerungsfreien
Druck der Platine. 

Falls wir die Oberseite einer Platine drucken
wollen muss zusätzlich noch mirror ausgewählt
sein, so das die Oberseite gespiegelt gedruckt
wird. 

Bild 34 ist die Druckausgabe die mit diesen
Einstellungen erzeugt wird.
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Abbildung 32: Platine mit den zu druckenden Teilen

Abbildung 33: Druckdialog

Abbildung 34: Ausgabe des Druckers
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4. Regeln für gutes Design

Das Design unseres Beispiels ist immer 
noch unbefriedigend. Besser ist da Bild 35.

Es ist zwar immer noch nicht ideal da eine
Leitung immer noch  zwischen zwei Pads
hindurch geführt wird, aber das Design ist
sehr viel besser als oben. 

Dieses Layout wurde übrigens auch mit dem
Autorouter gemacht (nach verschieben von
einigen Bauteilen).

Als Richtlinien für gutes Design kann man folgende Regeln ansehen:

●  Nur Unterseite für Leiterbahnen verwenden
●  Leitungen nicht zwischen Bauteilbeinchen verlegen
●  keine unnötig langen Leiterbahnen
●  genügend Abstand zwischen den Leiterbahnen halten
●  Leiterbahnen parallel verlegen
●  kein 90° Winkel (optimal sind 45°)
●  Vias und Pads groß genug machen
●  Stecker, Trimmer usw. nicht von oben anbinden (bei doppelseitigen Layouts)
●  Masseflächen verwenden.
●  .....
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Abbildung 35: gutes Layout
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Anhang

Schaltflächen des Layout editors

Info: Informationen über Bauelemente Show: Hebt Netzwerklinien hervor
Display: Welche Layer werden angezeigt Mark: Markiert Elemente
                                                                                             

Move: Verschiebt ein Element Copy: Kopiert Element                        
Mirror: Spiegelt das Element Rotate: Dreht Element                
Group: Gruppiert Elemente Change: verändert Elemteneigenschaft
Cut: Ausschneiden Past: Einfügen
Delete: Löschen Add: Fügt Bauteil ein
Name: Namen vergeben Value: weist Element einen Wert zu 
Smash: Trennt Namen/Wert von Element -   
Pinswap: Vertauscht Pins Replace: ersetzt Element
Split: Macht Linien rund Optimize: zeichnet krumme Linien gerade
Route: Leitungen ziehen Ripup: löst verlegte Leitungen
 -        

Wire: Linie/Verbindung ziehen Text: Text einfügen
Circle: Kreis zeichnen Arc: Halbkreis zeichnen
Rectangle: Rechteckige Fläche zeichnen Polygon: Fläche zeichen
Via: zeichnet eine Durchkontaktierung Signal: Signal verbinden
Hole: zeichnet eine Bohrung     
                                                                                                                

Ratnest: Berechnet kürzeste Verbindung Auto: Autorouter
ERC: Prüft Schaltung auf elektrische Fehler DRC: Prüft Schaltung auf Designfehler
Errors: Zeigt Fehler

Drucken - Kurzanweisung

• Zu druckende Layer wählen
o Layer Top bzw. Bottom, Pads, Vias, Dimensions für das Planinenätzen

• File > Print
• Druckeigenschaften einstellen

o Für Platinendruck: “sold”, “black”, “scale factor” = 1
 + für die Platinenoberseite (top) “mirror”
 Für die Platinenunterseite darf „mirror“ nicht gesetzt sein.

22/23



Eagle – Board Markus Valtin

Standartlayer von Eagle

Layout
1   Top Tracks, top side 2   - 15 Route Inner layer (signal or supply)
16  Bottom Tracks, bottom side
17  Pads Pads (through­hole) 18  Vias Vias (through­hole)
19 Unrouted Airwires (rubberbands) 20  Dimension Board outlines (circles for holes)
21  tPlace Silk screen, top side 22  bPlace Silk screen, bottom side
23  tOrigins Origins, top side 24  bOrigins Origins, bottom side
25  tNames Service print, top side 26  bNames Service print, bottom side
27  tValues Component VALUE, top ide 28  bValues Component VALUE, bottom side
29  tStop Solder stop mask, top side 30  bStop Solder stop mask, bottom side
31  tCream Solder cream, top side 32  bCream Solder cream, bottom side
33  tFinish Finish, top side 34  bFinish Finish, bottom side
35  tGlue Glue mask, top side 36  bGlue Glue mask, bottom side
37  tTest Test and adjustment,  top side 38  bTest Test and adjustment, bottom side
39
tKeepout

No go areas for components, top 40  bKeepout Nogo areas for components, bottom

41  tRestrict Nogo areas for tracks, top side 42  bRestrict Nogo areas for tracks, bottom side
43
vRestrict

Nogo areas for via­holes 44  Drills Conducting through­holes

45  Holes Non­conducting holes 46  Milling Milling
47
Measures

Measures 48  Document General documentation

49
Reference

Reference marks 51  tDocu Part documentation, top side

52  bDocu Part documentation, bottom side
Schematic

91  Nets Nets 92  Busses Buses
93  Pins Connection points  94  Symbols Shapes of component symbols
95  Names Names of component symbols 96  Values Values/component types

Preferred Directions des Autorouters:

Symbol Erklärung

- Nur vertikal verlegen.

| Nur horizontal verlegen.

\ schräg verlegen.

/ schräg verlegen

* Jede Richtung darf benutzt werden.

N/A Diesen Layer nicht benutzen.
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